
Microsoft Access 2007 Tutorial

Lesson 1: Getting Familiar with Microsoft Access 2007 for Windows

Microsoft Access is a database software package. A database is an organized collection of records. 
Telephone and address books are examples of paper databases. With Access, you can create a 
computerized database. For example, you can use Access to organize the students who attend a school, 
the courses they take, and the instructors who teach them.

Getting Started

You use windows to interact with Access. To begin, start Access 2007. You screen will look 
similar to the one shown here.

Understanding Security

It is possible for an Access database to contain malicious code, such as a computer virus. Access 
has security settings that disable code and display a security warning when you open a 
database. If you know a database is trustworthy, you can perform the following steps to enable 
it. You may need to enable the Northwind database.



To enable a database:

The Navigation Pane

To manipulate the Navigation pane:



The Title Bar

The Title bar is located at the top in the center of the Access window. The Title bar displays the 
name of the database on which you are currently working.

The Ribbon

Access Objects

To view or hide the objects on the Navigation pane:

 You click the double down-arrows to view objects. The double down-arrows change to 
double up-arrows .

 You click the double up-arrows to hide objects. The double up-arrows change to double 
down-arrows .

 icon tells you the object type: table, query, form, report, macro, and 
module.

Objects 



Tables In Access, data is stored in tables. A table is a set of columns and 
rows, with each column referred to as a field. Each value in a field 
represents a single type of data. Each row of a table is referred to 
as a record.

Queries You use queries to retrieve specific data from your database and 
to answer questions about your data. For example, you can use a 
query to find the names of the employees in your database who 
live in a particular state.

Forms Forms give you the ability to choose the format and arrangement 
of fields. You can use a form to enter, edit, and display data.

Reports Reports organize or summarize your data so you can print it or 
view it onscreen. You often use reports when you want to analyze 
your data or present your data to others.

Macros Macros give you the ability to automate tasks. You can use a 
macro to add functionality to a form, report, or control.

Modules Like macros, modules give you the ability to automate tasks and 
add functionality to a form, report, or control. Macros are created 
by choosing from a list of macro actions, whereas modules are 
written in Visual Basic for Applications.


 You double-click an object to open the object. You right-click an object to view a menu 

of options. You can use the menu to do such things as open objects, rename objects, 
and delete objects.



 Objects that are open appear on tabs. Right-click a tab to view a menu of options you 
can perform, such as save the object, close the object, or change the view.

 Change Views


 A view is a way of looking at an object. For example, in Access, data is stored in tables. 
Two of the possible ways you can view a table are Datasheet view and Design view. You 
can see the data contained in a table in Datasheet view. You can see the design of a 
table in Design view. When you open an object, buttons appear in the lower-right 
corner of the Access window. You can use the View button on the Home tab to change 
views, or you can click the proper button in the lower-right corner of the window.



Lesson 2: Creating Microsoft Access Tables

Tables are the foundation of an Access database. Access stores data in tables. This lesson 
teaches you how to create a table, add fields to a table, assign data types to fields, and set field 
properties.

Understanding Tables

A table is a set of columns and rows. Each column is called a field. Within a table, each field 
must be given a name and no two fields can have the same name. Each value in a field 
represents a single category of data. For example, a table might have three fields: Last Name, 
First Name, and Phone Number. The table consists of three columns: one for last name, one for 
first name, and one for phone number. In every row of the table, the Last Name field contains 
the last name, the First Name field contains the first name, and the Phone Number field 
contains the phone number. Each row in a table is called a record.

All of the data in a table should refer to the same subject. For example, all of the data in the 
Employees table should refer to employees, all of the data in the Students table should refer to 
students, and all of the data in the Courses table should refer to courses.

To add fields to a table:



1. Click the Add New Field column label.
2. Activate the Datasheet tab.
3. Click Rename in the Fields & Columns group.
4. Type the field name.
5. Press Enter. Access creates the field.
6. Type the next field name. Access creates the field. Continue until you have created all of the 

fields in your table. 
7. Press Enter without entering a field name to end your entries.

Name and Save a Table

After you create a table, you must name and save it.

To name and save a table:

1. Click the Save button on the Quick Access toolbar. The Save As dialog box appears.
2. Type the name you want to give your table.
3. Click OK. Access names your table.

Tip: You can use the Rename option at any time to rename any column. For example, 
you can rename the ID column Employee ID.



Understanding Data Types

In Access, you use data types to specify the type of data each field can capture. 

Data Types 

Data Type Use Notes

Text Alphanumeric data. Use for text 
and for numbers that are not 
used in mathematical 
calculations. Use for names, 
addresses, and other relatively 
short pieces of text. Can store up 
to 255 characters.

.

Memo Long text. Use for long pieces of 
text, such as notes and long 
descriptions. Can store up to 
64,000 characters.

Number Numeric data. Use for numbers 
you want to use in mathematical 
calculations.

If you are working 
with currency, use 
the currency type.

Date/Time Use for dates and times.

Currency Use for currency. Prevents rounding 
during calculation.

AutoNumber Unique sequential numbers or 
random numbers automatically 
inserted when you create a 
record. Use to create a primary 
key.

Yes/No Logical data. Use when only one 
of two values is valid. Yes/No, 
True/False, etc.



Hyperlink Use to store hyperlinks.

Attachment Use to store attachments.

OLE Object Use to attach an OLE object such 
as a Word document, Excel 
spreadsheet, or PowerPoint 
presentation.

To assign a data type or format to a field:

To use Design view to create a new table:

1. Activate the Create tab.
2. Click Table Design in the Tables group. Access changes to Design view and the Table Tools 

become available.



To set field properties:

1. Click the field for which you want to set the field properties.
2. Activate the General tab in the Field Properties area.
3. Set the properties you want to set.
4. Repeat steps 1 through 3 until you have set all the properties for all fields.



Create a Lookup Column

If a field can contain a finite list of values, you can create a Lookup Column and users can select 
the value they want from a list. For example, if the employees at a school can only work in one 
of the following departments: Administration, Computer Science, English, History, or Math. You 
can create a table Departments table that lists the departments and then use the list in the 
Employee table to assign each employee to a department.

Departments

Department ID Department

Primary Key

1 Administration

2 Computer Science

3 English

4 History

5 Math

Access has a wizard to help you create lookup columns. Creating a Lookup column creates a 
relationship between two tables. See the section Create Relationships in Lesson 3 to learn more 
about relationships.

To use the Lookup Wizard to create a lookup column:

1. Open the table to which you want to add a lookup column.
2. Click the field label for the field before which you want to add a lookup column.
3. Activate the Datasheet tab. (You must be in Datasheet view.)
4. Click the Lookup Column button in the Fields & Columns group. The Lookup Wizard 

appears.
5. Make sure the radio button next to “I want the lookup column to look up the values in a 

table or query.” is selected.
6. Click Next. The Lookup Wizard moves to the next page.



Open the Lookup Wizard

Select your table or query

A lookup column can be based on a table, a query, or a list of values you type. If you base your 
lookup column on a table or query, you must create the table or query before creating the 
lookup column. A query is a list of rows and columns based on one or more tables. A query only 
displays the rows and columns you specify.



1. Click a radio button to select what you want to base your lookup column on. Choose from 
Tables, Queries, or Both.

2. Click to select the table or query you want.
3. Click Next. The Lookup Wizard moves to the next page.

Select fields

You choose the fields you want to appear in your lookup column. Be sure to include the primary 
key.

1. Click the field you want.
2. Click the single right-arrow button . Access places the field in the Selected Fields column. Repeat 

this process to select additional fields. If you want all the fields in the table, click the double 
right-arrow button . Note: Use the single left-arrow and the double left-arrows to deselect 
fields.

3. Click Next. The Lookup Wizard moves to the next page.



Sort fields

The Lookup Wizard allows you to sort the records in a lookup column. You can display records 
in order, either ascending (alphabetical from A to Z, lowest number to highest number, earliest 
date to latest date) or descending (alphabetical from Z to A, highest number to lowest number, 
latest date to earliest date). You can also sort within a sort. For example, you can sort by state 
and then within each state by city, and then within each city by street address. If you are 
creating a sort within a sort, create the highest level sort on line one, the next level sort on line 
two, and so on. In the state, city, and street address example, you create the state on line one, 
the city on line two, and the street address on line three.

1. Click the down-arrow and then select the field you want to sort by.
2. Click to select a sort direction (the button toggles between ascending and descending). You can 

sort within a sort for up to four levels.
3. Click Next. The Lookup Wizard moves to the next page.

Adjust column widths

A key column is the column that connects one table or query to another table or query. For 
example, you can use the Department ID field in the Employees table and the Department ID 
field in the Departments table to connect the two tables. You may, however, want to display 
the name of the department when you view the table but not the department ID; if so, leave 
the Hide Key Column box checked.



1. Deselect Hide Key Column, if you wish.
2. Adjust the column widths by dragging or double-clicking the right vertical border for the column.
3. Click Next. The Lookup Wizard moves to the next page.

Specify the Key Field (if you deselected Hide Key Column)

A key field is a field that uniquely identifies a record. If you deselected Hide Key column, you 
must tell Access which field is the key field.

1. Click the key field.
2. Click Next. The Lookup Wizard moves to the next page.



Name the column

Field names appear at the top of each column. On this page of the Wizard you tell Access what 
you want to name your lookup column. In Access 2007, multiple values can appear in a field; 
click the Allow Multiple Values checkbox if you want to allow multiple values.

1. Type the name you want to give the column.
2. Click if you want to allow multiple values in the field.
3. Click Finish. Access creates the lookup column.

How do I create a lookup column by typing a list?

1. Activate the Datasheet tab. (These instructions assume you are in the Datasheet view.)
2. Click the Lookup Column button in the Fields & Columns group. The Lookup Wizard appears.
3. Click the radio button next to “I will type the values I want.”
4. Click Next. The Lookup Wizard moves to the next page.
5. Type the number of Columns you want in the Number Of Columns field.
6. Type the values you want under the column heading.
7. Click Next. The Lookup Wizard moves to the next page.
8. Type the column label you want.
9. Click Finish. Access creates a lookup column based on your list.



Lesson 3: Working with Microsoft Access Tables

After you create an Access table, you can modify it, enter data into it manually or import data
from somewhere else, such as Excel. This lesson teaches you how to modify a table and enter 
data.

Enter Records

After you have created a table, you can enter data into it. 

To enter data into an AutoNumber field:

 Press the Tab key. When you make an entry into another field in the record, Access will 
automatically make an entry into the AutoNumber field.



To enter data into fields that have a lookup list:

1. Click the down-arrow that appears when you click in the field.
2. Click to select the entry you want.
3. Press the Tab key.

To enter data into a Yes/No field:

 Click the checkbox for Yes; leave the checkbox unchecked for No.

Modify a Table

After you create a table, you may need to modify it. You can delete columns, insert columns, or 
move columns.

Delete Columns

The Delete option permanently deletes columns and all the data contained in them. You cannot 
undo a column delete.



To delete columns:

1. Click and drag to select the columns you want to delete.
2. Activate the Datasheet tab.
3. Click Delete in the Fields & Columns group. A prompt appears.
4. Click Yes. Access deletes the columns you selected.

Insert Columns

The Insert option inserts a column before the selected column.

To insert a column:



Lesson 4: Sorting, Filtering, and Creating Relationships 

You can sort Access data so you can view records in the order you want to view them, and you 
can filter data so you only see the records you want to see. This lesson teaches you how to sort 
and filter an Access table.

Access data is stored in multiple tables. Relationships join tables together so you can work with 
the data from multiple tables. This lesson also teaches you how to create relationships.

Sort a Table



By sorting, you can put a column of information in alphabetical, numerical, or date order. You 
can sort in ascending order (alphabetical from A to Z, lowest number to highest number, 
earliest date to latest date) or descending order (alphabetical from Z to A, highest number to 
lowest number, latest date to earliest date). You can also sort within a sort. For example, you 
can sort by state and then sort within each state by city. When sorting within a sort, perform 
the innermost sort first. For example, if you are sorting by state and then city, sort the city first 
and then sort by state.

To add a sort:

1. Click the column label for the column you want to sort.
2. Activate the Home tab.

3. Click the Ascending or Descending button in the Sort & Filter group. Access sorts the 
column in ascending or descending order.

To remove a sort:

1. Activate the Home tab.

2. Click the Clear All Sorts button in the Sort & Filter group. Access clears all of the sorts you 
have applied.

Filter a Table

You can apply a filter to see only the records you want to see. For example, perhaps your 
database contains students from the states of DE, NJ, and PA and you only want to see the 
students from DE. You can filter your data so only DE students display.

Each time you apply a filter to a column, it replaces any previous filter you applied to that 
column. For example, if you apply a filter so you only see students in DE, and later you apply a 
filter so you only see students in NJ, Access clears the DE filter and then applies the NJ filter.



You can apply filters to multiple columns in the same table. For example, by applying a filter 
first to the State field and then to the Last Name field, you can see all of the students in the 
state of DE whose last names are Adams.

To apply a filter:

1. Click the column label for the column you want to filter.
2. Activate the Home tab.
3. Click the Filter button. A menu appears.
4. Uncheck the items you do not want to appear, making sure only the items you want are 

checked.
5. Click OK. Access filters your data and displays the word Filtered at the bottom of the window.



To remove a filter:

1. Activate the Home tab.
2. Click Advanced in the Sort & Filter group. A menu appears.
3. Click Clear All Filters. Access clears all the filters you have applied.

Tip: After you apply a filter, you can use the Toggle Filter button to toggle the 
application of the filter on and off.

Hide Columns

There may be times when you may not want to display a certain column or set of columns. In 
such cases, you can temporarily hide the column or columns from view. Later, if you want to 
display them column again, you can unhide them.



To hide columns:

To create relationships:

1. Close all tables and forms. (Right-click on the tab of any Object. A menu appears. Click Close All.)

2. Activate the Database Tools tab.
3. Click the Relationships button in the Show/Hide group. The Relationships window appears.

4. If anything appears in the relationships window, click the Clear Layout button in the Tools group. 
If you are prompted, click Yes.

5. Click the Show Table button in the Relationships group. The Show Table dialog box appears.



6. Activate the Tables tab if your relationships will be based on tables, activate the Queries tab if 
your relationships will be based on queries, or activate the Both tab if your relationships will be 
based on both.

7. Double-click each table or query you want to use to build a relationship. The tables appear in 
the Relationships window.

8. Click the Close button to close the Show Table dialog box.

9. Drag the Primary table’s primary key over the related table’s foreign key. After you drag the 
primary key to the related table’s box, the cursor changes to an arrow. Make sure the arrow 
points to the foreign key. The Edit Relationships Dialog box appears.



10. Click the Enforce Referential Integrity checkbox.
11. Click Create. Access creates a one-to-many relationship between the tables.

12. Click the Save button on the Quick Access toolbar to save the relationship.

Tip: When you create a relationship, you can view the related table as a subdatasheet
of the primary table. Open the primary table and click the plus (+) in the far left column. The 
plus sign turns into a minus (-) sign. If the Insert Subdatasheet dialog box opens, click the table 
you want to view as a subdatasheet and then click OK. Access displays the subdatasheet each 
time you click the plus sign in the far left column. Click the minus sign to hide the subdatasheet.

Tip: After a relationship has been created between two tables, you must delete the 
relationship before you can make modifications to the fields on which the relationship is based. 
To delete a relationship.



Lesson 5: Creating Microsoft Access Queries

A query can be based on tables or on other queries. To create a query, you open the tables or 
queries on which you are going to base your query in Query Design view, and then use the 
options in Design view to create your query. You then click the Run button to display the 
results. You can save queries for later use.

To open tables or queries in Query Design view:

1. Activate the Create tab.
2. Click the Query Design button in the Other group. The Show Table dialog box appears.
3. Activate the Tables tab if you want to base your query on tables, activate the Queries tab if you 

want base your query on queries or activate the Both tab if you want to base your query on both 
tables and queries. 

4. Click to choose the table or query on which you want to base your query.
5. Click Add. The table appears in the window. 

a. Click to choose the next table or query on which you want to base your query.
b. Continue clicking tables or queries until you have all the tables and queries you plan to 

use.
6. Click Close. Access changes to Query Design view.

Display All Records and All Fields

In Query Design view, each table has an option that allows you to display all of the fields and all 
of the records in a table. This option appears on the field line on the drop-down menu as the 
table name followed by a period and an asterisk (tablename.*).



To display all records and all fields:

1. Open a table or query in Query Design view.
2. Click the down-arrow in the first field on the Field row and then select the tablename.* option. 

The table name appears on the table line.
3. Click the Run button. Access retrieves all of the fields and records for the table and displays 

them in Datasheet view.

Change from Datasheet View to Query Design View



After you run a query, you can easily change back to Query Design view and make modifications 
to your query or create a new query.

To change to Query Design view:

1. Activate the Home tab.
2. Click the down-arrow below View in the Views group. A menu appears.
3. Click Design View. Access changes to Query Design view. You can modify your query.

Tip: You can also click the Design button in the lower-right corner of the Access 
window to change to Design view.

Retrieve a Single Column

You can use an Access query to retrieve a single column of data. Instead of choosing the 
tablename.* option on the Field line in Query Design view, choose the name of the field you 
want to retrieve.



To retrieve a single column:

1. Open a table or query in Query Design view.
2. Choose the field name you want to display in the field line.
3. Click the Run button. Access retrieves the column you chose.



Retrieve Multiple Columns

You can use an Access query to retrieve multiple columns of data. On the Field line in Query 
Design view, choose the field name of each field you want to retrieve in the order you want to 
retrieve them.

To retrieve multiple columns:

1. Open a table or query in Query Design view.
2. Choose the field names you want to retrieve in the order you want to retrieve them.
3. Click the Run button. Access retrieves the columns you chose.



Sort a Query

When creating a query, you can sort the rows you retrieve in ascending or descending order by 
choosing the option you want on the Sort row in Query Design view.



To perform a sort:

1. Open a table or query in Query Design view.
2. Choose the field names you want to retrieve in the order you want to retrieve them.
3. Under the field you want to sort, click the down-arrow and then choose Ascending or 

Descending.
4. Click the Run button. Access retrieves the columns you chose and displays the rows in the order 

you specified.



Sort Multiple Columns in a Query

As you learned in the previous section, you can sort the rows your query returns. You can also 
create sorts within a sort. For example, you can sort by state and then within a state, you can 
sort by last name and then by first name. You specify the sort in the order you want the sort to 
occur. If you want to sort by state and then by last name within a state and then by first name 
within last name, you enter the sort in the following order: city, last name, first name. Your sort 
order may not agree with the order in which you want to display fields. In such a case, you can 
use fields that do not display to enter your sort order. To prevent a field from displaying, 
deselect the Show box on the Show row.



To sort multiple columns:

1. Open a table or query in Query Design view.
2. Choose the field names you want to retrieve in the order you want to retrieve them.
3. Choose the field names you want to sort by in the order you want to sort.
4. Under the fields you want to sort by, choose Ascending or Descending.
5. Deselect the Show button for the columns you do not want to display.
6. Click the Run button. Access retrieves the columns you chose and displays the rows in the order 

you specified.



Create a Query That Uses Two or More Tables

If you want to view data from two or more tables or queries, you can create a query that pulls 
the data from multiple tables or queries. The tables and queries from which you pull your data 
should have a relationship.



To create a query that uses two or more tables:

1. Open the tables and/or queries you want to use in Query Design view.
2. Choose the field names you want to retrieve in the order you want to retrieve them.
3. Choose the field names you want to sort by in the order you want to sort. Under the fields you 

want to sort by, choose Ascending or Descending.
4. Enter your selection criteria, if necessary (Not applicable in this example).
5. Deselect the Show button for columns you do not want to display (Not applicable in this 

example).
6. Click the Run button. Access retrieves the columns you chose and displays the rows in the order 

you specified.

Save a Query

After you create a query, you can save it. You can rerun a saved query at any time. If you 
change the data on which the saved query is based, you will see the changes when you rerun 
the query.



To save a query:

1. Click the Save button on the Quick Access toolbar

. Access saves the query unless you are saving for the first time. If you are saving for the first 
time, the Save As dialog box appears.

2. Type the name you want to give your query.
3. Click OK. Access saves the query. You can now access the query by using the Navigation pane. 

Create a Parameter Query

If instead of entering predetermined criteria, you want to prompt users when a query runs, you 
can create a parameter query. You create a parameter query by enclosing a question in square 
brackets ([]). For example, if you want to create a parameter query that asks users which State 
they want to use from the Student’s table, you would type [Which State?] on the Criteria line 
under the State column. When the query runs, Access will prompt the user for the answer to 
your question.



To create a parameter query:

1. Open a table or query in Query Design view.
2. Create your query.
3. On the Criteria line, type the prompt within square brackets.
4. Click the Run button. Access prompts you.



Lesson 6: Creating Forms

Access forms are much like paper forms: you can use them to enter, edit, or display data. They 
are based on tables. When using a form, you can choose the format, the arrangement, and 
which fields you want to display. This lesson teaches you how to create forms.

Using the Form Button

Access can automatically create several types of forms. For example, when you click the Form 
button on the Create tab, Access places all fields in the selected table on a form. If the table has 
a one-to-many relationship with one other table or query, Access creates a stacked form (the 
records are displayed in a column) for the primary table and a datasheet for the related table. If 
there are several tables with a one-to-many relationship, Access does not create the datasheet.

To create a form:

1. Open the Navigation pane.
2. Click the table or query on which you want to base your form.
3. Activate the Create tab.
4. Click Form in the Forms group. Access creates a form.



You can use the Navigation bars to move through the records on a form.

1 Go to First Record

2 Go to Previous Record

3 The Current Record

4 Go to Next Record

5 Go to Last Record

6 Create a New (Blank) Record

Tip: After you create a form, you can save it. You can open a saved form at any time.



To save a form:

1. Click the Save button on the Quick Access toolbar. Access saves the form unless you are saving 
for the first time. If you are saving for the first time, the Save As dialog box appears.

2. Type the name you want to give the form.
3. Click OK. Access saves the form. You can now access the form by using the Navigation pane.

You can also save by right-clicking a form’s tab and then selecting Save from the menu that 
appears. Access saves the form unless you are saving for the first time. If you are saving for the 
first time, the Save As dialog box appears. Type the name you want to give the form and then 
click OK. Access saves the form. You can now access the form by using the Navigation pane.

Create a Split Form

A split form is a form in which the same data is displayed in two views simultaneously. One part 
of the form displays in Form view (stacked fields), while the other part displays in Datasheet 
view. The two views are synchronized, so as you select a field in one view, it is automatically 
selected in the other view. You can add, change, or delete the data in either view. Using a split 
form gives you the benefits of two types of forms in a single form. For example, you can use the 
datasheet portion to locate records and the form portion to edit records. 



To create a split form:

1. Open the Navigation pane.
2. Click the table or query on which you want to base your form.
3. Activate the Create tab.
4. Click Split Form in the Forms group. Access creates a split form.



Create a Multiple Items Form

You can use the Multiple Items button on the Forms tab to create a form that displays multiple 
records, one record per row.



To create a multiple items form:

1. Open the Navigation pane.
2. Click the table or query on which you want to base your form.
3. Activate the Create tab.
4. Click Multiple Items in the Forms group. Access creates a multiple items form.



Tip: A view is a way of looking at an Access object. Forms have three views: Form 
view, Layout view, and Design view. You can enter, edit, and view data in Form view. You can 
modify a form in Layout view or Design view. In Layout view, you can see your data, and the 
form you see closely resembles what your form will look like when you view it in Form view. 
You can make most, but not all, changes to your form in Layout view. Design view displays the 
structure of your form. In this view you cannot see the underlying data, but you can perform 
some tasks in Design view that you cannot perform in Layout view. This tutorial focuses on 
Layout view.

To change the view:

1. Open the form.
2. Activate the Format tab.
3. Click the down-arrow under the View button. A menu appears.
4. Click the view you want.

Modify a Form

After you create a form, it opens in Layout view, where you can modify it.

To change the size of a field:

1. Click a side of the field and drag to change the width of the field.
2. Click the top or bottom of a field and drag to change the height of a field.



To move a datasheet:

1. Click the datasheet to select it.
2. Click and drag the four-sided arrow in the upper-right corner to move the datasheet.

To resize a datasheet:

1. Click the datasheet to select it.
2. Click a side of the datasheet and drag to change the width.
3. Click the top or bottom of the datasheet and drag to change the height.

To apply an AutoFormat:

The AutoFormat option on the Format tab enables you to apply formats quickly, such as 
background colors, field colors, field label colors, and fonts.

1. Activate the Format tab.
2. Click AutoFormat. The AutoFormat menu appears.
3. Click the format you want to apply.

To change a form title:

When you create a form, by default, Access uses the form name as the title. You can change the 
title.

1. Activate the Format tab.
2. Click the Title button.
3. Type the new title.



Lesson 7: Creating Reports

Reports organize and summarize data for viewing online or for printing. A detail report displays 
all of the selected records. You can include summary data such as totals, counts, and 
percentages in a detail report. A summary report does not list the selected records but instead 
summarizes the data and presents totals, counts, percentages, or other summary data only. 
Access has several report generation tools that you can use to create both detail and summary 
reports quickly. This lesson teaches you how to create reports.

Use the Report Button

The Report button creates a simple report that lists the records in the selected table or query in 
a columnar format.

To use the Report button:

1. Open the Navigation pane.
2. Click the table or query on which you want to base your report.
3. Activate the Create tab.
4. Click the Report button in the Reports group. Access creates your report and displays your 

report in Layout view. You can modify the report.



END


